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Rampage Remote Proof
User 

Before You Begin
There are a few things that you need to check prior to using Rampage Remote 
internet proofing.

❏ 1. �Make sure you have internet access.

❏ 2. �System Requirements for your computer. These can be found on 
page 2.

❏ 3. �The URL or IP address of the Rampage Remote server. This 
information will be supplied from your printing facility’s 
Rampage Remote Administrator.

❏ 4. �Have your User name and Password for login information. 
This information will be supplied from your printing facility’s 
Rampage Remote Administrator.

Steps to Using Rampage Remote

Below are a few steps to get you started in using Rampage Remote. For more 
detailed information on all of the features, please refer to the rest of this 
document.

  1.	 Open your web browser (Firefox, Internet Explorer, Safari). See 
system requirements on page 2.

  2.	 Type the URL or IP Address of the Rampage Remote server.

  3.	 When the login window appears, type in your username and 
password, then click Login.

  4.	 When the Main menu appears, click Proof or the magnify glass 
icon.

  4.	 The Page Browser window will open. Select a Job from the 
Customers & Jobs list on the left.

   5.	From the area on the right, select pages to proof.

Once you have a page open, you have the ability to make annotations, approve, 
reject, compare revisions, etc.
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Rampage Remote

Rampage Remote allows you to view, annotate, approve/reject and download 
Rampage soft proofs over the Internet. This documentation explains how to use 
Rampage Remote.

System Requirements
There are some basic system requirements. Pay close attention to memory and 
Java requirements. See “Checking Java Version”  later in this document for more 
information. 

Apple Macintosh OS X 10.3.9 or later
Mac�intosh Runtime for Java 1.4.x or later (OS X 10.3.9 only 

supports Java 1.4.x)
RAM: 512 MB 
Internet Browser Applications supported: 
• Firefox 2.0 or later 
• Safari 2.x or later

Microsoft Windows
Windows NT / 2000 / XP /Vista
RAM: 512 MB 
Java Runtime Environment 1.5.x or later 
Internet Browser Applications supported: 
• Firefox 2.0 or later 
• Internet Explorer 6.0 or later 

Checking Java Version / Obtaining Java

Windows NT / 2000 / XP / Vista

On most Windows systems, you can determine the version of Java you have. 
Go to Start -> Run type cmd to bring up the command prompt and type java 
-version. If you are unsure of the version, it does not hurt to install the latest 
version from Sun.

If you do not have Java installed on your computer, you will need to obtain the 
latest Java Runtime Engine or library. Go to www.java.com to obtain the latest 
Java installation for your system.

Important! �You must install Java before logging in to the Rampage Remote 
server. The proof module will not work if tried before Java is 
installed.
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Apple Macintosh OS X 10.3.9

All versions of Mac OS X come with Java pre-installed. Make sure you have 
the version Java 1.4.x. You can determine the version of Java by going to the 
Utilities folder -> Java folder. If you do not have a Java folder or at least Java 
1.4.x, use Software Update in the System Preferences to obtain the latest Java for 
your version of Mac OS X. 

Important! �Mac OS X 10.3.9 does not support the Upload module of Rampage 
Remote. You will need to update to at least Mac OS X 10.4.x with 
Java 1.5.x.

Apple Macintosh OS X 10.4.x and above

All versions of Mac OS X come with Java pre-installed. Make sure you have the 
version Java 1.5.x or later. You can determine the version of Java by going to the 
Utilities folder -> Java -> J2SE 5.0 folder and launch the Java Prefs application. 
If you do not have a J2SE 5.0 folder, use Software Update in the System 
Preferences to obtain the latest Java for your version of Mac OS X 

Once the Java Preferences window is open, make sure J2SE 5.0 is selected.

	

Important! �You must install Java before logging in to the Rampage Remote 
server. The proof module will not work if tried before Java is 
installed.
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Log in to Rampage Remote
Users can launch Rampage Remote with a single click within your Internet 
Browser. Java 1.4 or above is required.

1.	 Launch your internet browsing application

2.	 Type the IP address or URL of the Rampage Remote Server, a 
web page similar to the one below appears. This is the home page 
of the Rampage Remote Server.

 

 3.	 Type in your Username and Password set up by the Rampage 
Remote Administrator. Click the Login button to log you into 
the Rampage Remote Server.

4.	 The Rampage Remote Main Menu window appears.
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�Using Rampage Remote
1.	 From the Main Menu, click Proof Pages.                

2.	 You are now presented with the main Rampage Remote Proof 
screen along with a Page Browser.

3.	 Open the Page Browser window to fill your screen. Click the 
Customers & Jobs tab to view the column.

4.	 The Customers and Jobs are listed in the left column of the Page 
Browser. See the section describing the Page Browser in detail 
later in this document.

5.	 Double-click on a Job or select multiple jobs and click Find 
Pages. All of the Pages available to proof will appear to the right.
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Opening a Proof

Double-click on a page to open the proof. In the proof window, you can zoom in 
or out, make annotations, check ink mixes, and approve/reject the page.

	 Note: �The ability to approve, reject, download, compare and annotate are 
user privileges your Rampage Remote Administrator will set up.

Understanding Rampage Remote

File Menu (Mac left, PC right)

  

Print
This will print the proof that is currently open. If the file is enlarged, 
has guides, annotations open, etc., that is what will print, basically it 
is a screen shot of the proof window. A Print icon is at the top of the 
proof window in the tools palette as well. 

Download Proof
When viewing a Proof, you can download a file that can be printed. 
See the section Downloading Proofs later in this document.
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Preferences
Selecting this pull-down will bring up the preferences window. 
There are five buttons described below.

	 Rulers & Guides

	 	

		  Ruler Units
		�  Change measurement units of the Proof window between 

inches and centimeters.

		  Locator Units
		�  Change locator units between pixels, centimeters and 

inches. The Locator units are also displayed at the bottom 
of the Proof window. This X and Y coordinate indicates 
where the cursor is located on the proof being viewed.

		  Guides Color
		�  Changes the color of the proof guides as they appear in the 

proof window. There are several preset colors as well as 
access to a color picker under the Custom Color option.

		  Trim Color
		�  Changes the default color of the trim guides as they 

appear in the proof window. There are several preset 
colors as well as access to a color picker under the 
Custom Color option.

		  Mask Color
		�  Changes the default color of the mask used when comparing 

revisions. There are several preset colors as well as access to a 
color picker under the Custom Color option.
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	 Display

	

	� If your monitor has been color calibrated, you can select an ICC profile to 
color correct a Proof when it is opened.

		  ICC Profile Folder
		�  Use the browse button to navigate to the ICC Profile 

folder on your system.

		  Monitor ICC Profile
		�  Select an ICC Profile from the pop-up menu that 

characterizes your Monitor.

		  Open New Proofs
		�  Select either Inside or Outside the Browser. Inside will 

open the proof in the current browser window. Outside 
will open the proof in a new window.

	 Annotation

	

		  Font/Size
		�  Choose the Annotation font and font size. This is the font 

that Annotations will use.

		  Point Shape/Size
		�  When creating a Point Annotation, you have the choice of 

what shape it will be. Select the default icon shape from 
the pop-up menu. The choices are Target, Circle, Box or 
Triangle.

		�  With the Point Size slide bar, you can choose the size of 
the icon.
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	 Keymap

	

		  Load standard keymap
		�  The three choices for standard keymaps are Default, 

Photoshop and TrapIT. You can select a standard keymap 
and then customize.

		  Rebind/Clear binding
		�  If a command already has a binding assigned to it, you 

can Clear Binding to clear the command, then highlight 
the entry and press Rebind or double-click the entry to 
type in a new key combination for that command.

	 Notifications

	

		  Receive Notifications
		�  If you have e-mail notifications enabled through your 

Rampage Remote user, you can select where to receive 
the notices. You can receive notices in two places. If 
in my e-mail box is selected, you must have a valid 
e-mail address in your profile. If in my Rampage Remote 
message center is selected, then notifications will be sent 
to your Message Center Inbox. For more information on 
the Message Center, see that section later in this chapter.

		  E-mail Format
		�  Select the format you want to see the notifications. 

Since most e-mail programs support HTML, that is the 
recommended format.
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Profile
You can update any necessary User Profile information. 

	 Important! �The E-mail needs to be set up in order to receive e-mail 
notifications from the Rampage Remote Server.

	

Change Password
Allows you to change your login password. Type in your Old 
Password, the New Password then confirm the New Password. The 
next time you login to the Rampage Remote Server you will need to 
use the New Password.

	

Logout
Selecting Logout will log you out of the Rampage Remote server. A 
Logout button as been added to the Tool menu as well.

Edit Menu (Mac left, PC right)

         

Select All
When in the Page Browser you can use the Select All feature to 
select all of the pages in the different views to Approve, Reject, or 
Download a group of pages.
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View Menu (Mac left, PC right)

         

Zoom, Rotate, Rulers, Annotations
There are many combinations of views that you are able to set in 
Rampage Remote. These views are available when viewing a proof.

Hide/Show Trim Lines
Toggle this on and off to view the Trim lines.

Display Trim/Bleed
Select to display the page out to the Trim or Bleed size.

Guides
Once page guides are created, you can Hide, Lock, Clear, and Save. 
After a set of guides has been saved and you want to use the same 
set of guides for another page, select Load Guides and navigate to 
the correct set of guides.

Window Menu (Mac left, PC right)

       

Hide/Show System Window
The System Messages window comes up when you first connect to 
the Rampage Remote Server. It shows system messages.

Hide/Show Page Browser
The Page Browser window shows up when you connect to the 
Rampage Remote Server. For more information, see the section 
Page Browser later in this document.
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Hide/Show Job Browser
The Job Browser window will display stats for jobs like total pages, 
total pages ripped, etc. For more information, see the section Job 
Browser later in this document.

Hide/Show Navigator
The Navigator window is a thumbnail view of the entire page. Using 
the Hand/Move tool while zoomed in on area, click anywhere on the 
thumbnail and your page window will update.

Hide/Show Annotation
The Annotation window will give you a numbered list of all the 
annotations on the page. For more information, see the section on 
Annotations later in this document.

Hide/Show Proof Information

	 Info
	� Shows the general information of the currently viewed proof. It contains 

the status, revision number, document size, inks, and dpi of the page.

	 Decisions
	� Shows which users have decided whether the proof is approved or 

rejected. It also shows each user’s decision.

	 History
	� Shows the history of each page. This tab can contain information 

relating to the date and time the page is published for review, 
annotated, revised, and approved/rejected.

Hide/Show Notifications
The Rampage Remote Administrator has to set your User permission 
to have the ability to Request E-mail Notifications. Once this is set 
up, you have the option to change the Notification requests for each 
Job that is assigned to your User.
Choose a Job to change the receipt of notifications for that Job. Your 
User is set with the notifications checked allowed by the Rampage 
Remote Administrator. If the option is not available to be changed, it 
will be grayed out. You can also change the e-mail frequency of each 
notification. Each Job needs to be set up unless you want to leave the 
settings at the default. If you make any changes, click Apply.
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Hide/Show Download Manager
Shows a list of pages that have been downloaded during this session 
with the Rampage Remote Server. For more information, see 
Downloading Proofs later in this document.

Hide/Show Message Center
Show Message Center and select a message to view, a window 
similar to the one below appears. When letter icon at the top of the 
Rampage Remote window flashes red, it means you have a message. 

	 Compose
	   �    Click Compose to send a message to a user within the 

Rampage Remote. You cannot use the Message Center to send 
messages to anyone outside of your Customer’s Users.

	 Reply/Reply All/Forward/Delete
	   �    You can Reply, Forward, etc. messages received in the 

Message Center. You cannot reply to the System notifications.

	 Delete
	       Click Delete to remove messages from the Message Center.

	 Address Book
	   �    See below.

Hide/Show Address Book
Shows a list of users within your Rampage Remote database. This 
list is comprised of Users that are located in your Customer only. 
You can Send, Forward, or Reply to messages.
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Pages
The last section of the Window menu contains the name of any 
proofs open. You can select one at a time to make active. You can 
view more than one proof at a time by changing the size of the 
proofs window.

Help Menu (Mac left, PC right)

 

About
Shows the version of Rampage Remote currently running.

	 Note: �To learn more about Rampage Remote, please refer to the Main Menu 
and select Help. There you will find documentation in PDF format 
and instructional videos to download.

Rampage Remote Window

The Rampage Remote window contains several elements that help you find 
and navigate proofs. These consist of the Tools palette, the Page Browser, the 
Navigator, and, finally, the Proof window. 

Tools Palette

Each tool except Reject and Approve have keyboard shortcuts. The default 
shortcuts are shown in ( ) next to the tool name. 

  Selection Tool (v)
The Selection Tool is used to expand, move, select and/or append 
annotations on the page, and also to create and move page guides.

  Move Tool (Pan Tool) (h)
When you are zoomed in to see part of a proof in a Proof Window, 
the Move Tool allows you to pan within the window.

  Densitometer Tool (i)
The Densitometer Tool allows you to check the ink densities and mix.

  Zoom Tool (z)
The Zoom Tool allows you to zoom in and out of a proof. To use it, 
either click-and-drag on the proof or Navigator thumbnail to select 
an area you wish you zoom into or away from. The default state of 
the Zoom Tool is to zoom in. If you want to Zoom out, hold down 
the CTRL key on both the Mac and PC.

  Annotation Tools: �Point (t), Rectangle (r), Oval (o)
The three Annotation Tools are used to create annotations. An 
annotation is a text note that you create on a proof to alert your 
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printer about something that needs to be changed. For more 
information, see the Annotations section.

  Message Center
Select the icon to open the Message Center window. When the 
Message Center icon is flashing red, Notifications or Messages are 
waiting to be read.  

�  Reject/Approve Tools
The X is for rejecting the Proof. The √ is for Approving the Proof. 
When you select one of these tools, a window will pop up to type 
comments and either Reject or Approve. 

�  Printer
This will print the proof that is currently open. If the file is enlarged, 
has guides, annotations open, etc., that is what will print, basically 
a screen shot of the proof window. Print has been added to the File 
menu as well. 

�  Logout
Click Logout to log out of the Rampage Remote server. Logout has 
been added to the File menu as well.

�Page Browser

The Page Browser displays the list of pages that you can proof. There are four 
different views to choose from: Book, Icon, List, Details, the default view is 
Details. There are status markers to let you know when a page is approved, 
rejected, under review or needs your attention. Double-clicking on pages opens 
the proof. The top of the Page Browser has four icons.

Views
This menu allows you to select the view of your Page Browser. The 
choices are Book, Icon, List, and Details all described below.

Sort
This menu allows you to sort the pages in the Page Browser by the 
page status or needs your attention column.

Refresh
Clicking Refresh will update Pages in the right panel of the Page 
Browser as well as update the left panel where all customers and 
jobs are located.

Stop
Clicking Stop will stop updating Page thumbnails while in the Icon 
or List views. If stopped, the Page box will have a “?”
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Details View

Customers & Jobs Tab
This tab area shows a list of Customers and Jobs available. Typically 
you will only see one Customer, your own, but you could see many 
Jobs. Once you select a Job(s) to view in the Page Browser, either 
double-click the Job or click “FIND PAGES” at the top of the 
column. All of the Pages related to the Job(s) are displayed in the 
Page Browser.

	 Customer Reference
	� The Customer Reference is in parentheses next to the Job name. 

This helps the customer determine which Job they are proofing 
as compared to an internal Job number. Customer Reference is 
shown only if it was added by your printer.  

Column width can be resized by clicking on the line between columns and 
adjusting to the left or right. Each column can be sorted by clicking on the 
column header. Columns can be hidden by ctrl-click Mac, (right click PC) on 
column header to get the following contextual menu.

 Attention 
The first column doesn’t contain a header description. If an “!” 
appears in this column it states that this particular Page needs your 
attention. If it is blank, you have already looked at this Page and 
either approved or rejected it.

ID
This is the number of the Page in the Rampage RIPing system. It 
identifies an internal Page ID number.

Page Name
This is the name of the page to be proofed. This is the only column 
that cannot be hidden by the User with Rampage Remote.

Status
This column will indicate the status of the page. A green “√” states 
that the Page has been approved. A red “X”  states that the Page 
has been rejected. A magnifying glass indicates that the Page is still 
under review.
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Revision
This column shows the revision or correction number of the Page. 
If a Page has been corrected and resubmitted for review, the number 
will change to “2”.  The numbers will continue to change for as 
many revisions take place.

Job Name
The Job Name column reflects which pages belong to which job.  

Customer
The name of the customer to which the pages of a job belong. 

The following columns may or may not be viewable to your User.
Operator

This column identifies the Rampage MacOS client that registered 
this page into the Rampage RIPing system.

Workflow
This column indicates whether the Page was RIPed through the 
ROOM or NORM workflow.

Prescan, Trap, Rip, FPO, Plot
The columns are the same columns as the ones you see in your 
Rampage MacOS client. They show the status of a page as it travels 
through the Rampage workflow. More information can be found in 
the main Rampage System documentation.

	 Note: �The contextual menu (ctrl-click Mac, right click PC) is a shortcut for 
changing views, font, and font size for the Details view.

Icon View

In Icon View you see a thumbnail picture of every Page. In this window, you can 
tell if a Page has been Approved (√), Rejected (X) Under Review (no icon) or 
Needs your Attention (red box around Page).

Note: �The contextual menu (ctrl-click Mac, right click PC) is a shortcut for 
changing views, icon size, font, and font size for the Icon view.
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  List View

The List view gives you more information than the icon view. You see a 
thumbnail picture, revision number, whether the Page has been Approved, 
Rejected, or Under Review and a list of Users and their decision on the Page. If a 
file name is in red text, the Page needs your attention.

  Book View

The Book view may not be available for every Job. It is only available if 
implemented by the Rampage Remote site.

The Book view shows a thumbnail of every Page in book order. In this window, 
you can tell if a Page has been Approved (√), Rejected (X), Under Review (just 
the thumbnail, no icon) or Needs your Attention (red box around Page).

In book view of the Page Browser, blank pages will display a page icon of a 
blank page. The name of the page will display as <Blank>. For pages that have 
not been assigned will display a page icon of a “?” and the name of the page will 
be <Unassigned> (See graphic above.).

Navigator  

The Navigator shows a thumbnail of the entire proof. 
The Show/Hide Navigator is located under the Window  
menu. This is useful for when you’re zoomed into a  
particular area of a proof. A box will appear that shows  
you the area you’re viewing. You can then use the Move  
tool to move the box elsewhere on the thumbnail, thus  
changing your view inside the Proof window.
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Proof Window

The Proof window is where you view the page proof. Open a Proof window by 
double-clicking on a page. The Proof window elements are described below.

Rulers: Horizontal and Vertical
Rulers allow you to measure distances. Rulers can be hidden by 
using Ctrl-R, clicking the View menu, then Hide Rulers or by the 
Ruler tool at the bottom of the page. 

Ruler Zero/Zero Tool
Located at the upper left of the Proof Window, where the two rulers 
meet, is the Zero/Zero tool. Clicking and dragging this area allows 
you to change where Zero (0) begins. This is useful for measuring 
between objects in a proof. In order to return Zero/Zero to the upper 
left of the entire page, double-click the Zero/Zero Tool.

Guides
With the selection tool, you can pull guides out from each ruler. 
Guides are useful for checking object alignment or to measure 
distances between objects. Guides can be hidden by using Ctrl-G, 
clicking the View menu, then Hide Guides or by the Guide tool at the 
bottom of the page. To delete an individual guide, click-and-drag it 
off the Proof using the Selection tool.

	 Note: �For more information on Guides, see the View menu -> Guides 
section earlier in this chapter.
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Proof Status
A banner at the top of the Proof Window will state whether the Page 
has been Approved, Rejected, or Under Review.

	 Note: �Annotations also show in the Proof Window. See Annotations for 
more information.

At the bottom of the Proof Window are short-cuts to some of the Views and 
Status of the Page.

Revision
Shows the Revision or correction number of the Page. If there is 
more than one revision (the number is greater than 1), you can click 
on the Revision to view previous revisions.

%
Shows the percentage size of the Page being viewed. If you click in 
that area, a pop-up window appears. Choose between Fit In Window, 
Zoom In, or Zoom Out.

°
Shows the degree the Page is rotated. Click in that area to rotate the 
Page to be at 0°, 90°, 180°, 270°. This area works differently than 
the View menu. The View menu rotates by changing the Page view 
rotation by the degree chosen, not setting it to a specific degree.

X Y
Shows the X and Y coordinates of the curser on the page. Click in 
the area to select the units of measure to view the coordinates. The 
choices are Pixels, Inches, Centimeters.

Rulers, Trim Lines, Crop,  Guides, Annotations
These icons toggle on/off the view of Rulers, Trim Lines, Crop, 
Guides and Annotations for the Page.

Status
Shows if a Page is Approved, Rejected, or waiting for a decision.

Book View Tools
The Book View may not be available for all Jobs. It is only available 
if implemented at the Rampage Remote site. When you view a 
page that has the capability of viewing as a book, the bottom of the 
Proof window changes to the one below. The top half of the area is 
for viewing pages, either single or reader spreads. You can toggle 
through each page. Click on one of the icons to the far right to 
display a single page or reader spreads.

	 Note: �When viewing as reader spreads, none of the shortcuts are available. 
(Revision, percentage, rotate, etc.)
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Proof Information
To the left of the Proof Window is a Tab area. Click on a Tab to open 
the column. Clicking on the same Tab again will close the column.

	 Pages
	� A Pages tab has been added to the tab area of a proof for easier 

access to pages.

	       Sort
	       �At the top of the Pages tab is a Sort pull-down. Use this 

to change the display order of the Pages. You can sort by 
Alphanumeric, Status, Needs Your Attention, and Book Order.

	       Page Status
	       �Each Page’s status can be viewed in the Pages Tab by the color 

of the Page text. Red for rejected, Green for approved, Bold 
for needs your attention. Not bold means that you have made 
your decision and other decisions are pending for the page to 
be approved or rejected.

	 Info
	� Shows you the general information of the currently viewed proof. 

It contains the status, revision number, document size, and dpi of 
the proof.

	 Compare
	� Gives the ability to compare two revisions of a page on a pixel 

basis. See Page Revision Compare later in this document.

		    Note: �The Compare tab will not be available if the page does not have 
more than one (1) revision or if a User was not given permission for 
the Compare access control.

	 Inks
	� Shows all of the inks in the Page. To turn some inks off, uncheck 

the box next to the ink name. Click “APPLY CHANGES” at the 
top of the column to view the updated information.

	 Decisions
	� Shows the Approval List and the decision of each user.

	 History
	� Shows the history of each page. This tab can contain information 

relating to the date and time the page is published for review, 
annotated, revised, and approved/rejected.
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Page Revision Compare

�Page Revision Compare gives the ability to compare two revisions of a page 
on a pixel basis. The difference is done between the monitor proofs of the two 
revisions.

Using Compare
  1.	 From the Page Browser window, open a revised page.

  2.	 Click on the Compare tab from the left of the Page window.

		    Note: �The Compare tab will not be available if the page does not have 
more than one (1) revision or if a User was not given permission for 
the Compare access control.

  3.	 Check the box next to Compare to: From the first pop-up menu 
select the Revision to compare the open page with. This pop-up 
menu will list all of the revisions of a page. You can select one at 
a time.

  4.	 The second pop-up menu has two selections Mask Same Pixels 
and Mask Different Pixels, select one. You can change the Mask 
Color by clicking on the box and choosing another color.

  5.	 After all of the settings have been selected, click Apply 
Changes.

The following screen shots show the two different Mask selections.

Mask Same Pixels
	� If this is selected Rampage will use the color chosen in the Mask 

Color box to mask all pixels that are the same on both pages. The 
default mask color is white, leaving the differences in black.
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Mask Different Pixels
	� If this is selected Rampage will use the color chosen in the Mask 

Color box to mask (highlight) all pixels that are different from 
the selected revision page. The default mask color is green unless 
changed in the preferences of Rampage Remote.
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Annotations
An annotation is a text note that you create on a proof to alert your printer about 
something that needs to be changed. They can contain anything from instructions 
to corrections. There are three different types of Annotations; Point, Rectangular 
and Oval.

Each Annotation has a Contextual menu. You can Append, Remove, or Lock an 
annotation; change the Icon shape and size of the annotation; change the Font 
and size of the annotation. When an annotation is selected on the proof or in the 
Annotations Window, ctrl-click Mac, right-click PC to see the contextual menu.

       Note: �Annotations can only be Removed or Locked by the original 
creator.

Creating Annotations 
1.	 Open a proof and zoom in on the area you wish to Annotate.

2.	 Choose one of the Annotation tools from the Tools Palette. 

	   ��Pointer  – Click on the Page to place the Point Annotation and type 
into the window. When done, the Point Annotation icon will appear on 
the Page.

	   �Rectangular  –  Click on the Page for the starting point of the 
Rectangular Annotation and drag to the desired size. Type in the 
window provided and the Rectangular Annotation icon will appear on 
the Page.

	   �Oval  –  Click on the Page for the starting point of the Oval Annotation 
and drag to the desired size. Type in the window provided and the Oval 
Annotation icon will appear on the Page.

3. 	 When you click on the area of the proof on which you wish to 
make your Annotation. The following dialogue box appears:
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4. 	 Type the note or change you wish to leave for the printer in the 
box, then click the OK button.

5. 	 The Proof Window will update to show an icon of the 
corresponding Annotation tool. Each icon represents the actual 
annotation text.

Viewing Annotations

There are two ways to view Annotations: using the Selection Tool or the 
Annotations window.

To view/expand an Annotation using the Selection Tool: 

1. 	 In the Tools Palette, select the Selection Tool  .

2.	 Click on the Annotation icon you wish to view. A window pops 
up with a line connecting to the Icon. This annotation window 
shows the number of the annotation, all of the annotations 
entered, what user placed the annotation, the date and time it was 
entered.
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To view Annotations through the Annotations Window: 

1.	 Click the Window menu, then select “Show Annotation 
Window.”  A dialogue similar to the one below will open.  

2.	 The window shows a list of all the annotations on the page. 
Clicking the triangle down next to a number shows all the 
appends for that particular annotation. The last annotation 
entered is listed next to the number.

	 Note: �If you click the User in the Annotation Window, you will get a 
window with the User’s Profile information. This is a quick way to 
identify the User.

Appending Annotations

Appending an Annotation means to add a comment to an already existing 
Annotation. You may want to do this if an existing Annotation is inaccurate or 
there are follow-up changes.

When you append an Annotation, the Annotation Window displays the last 
change at the bottom of the list.

To append an Annotation using the Selection Tool: 

1. 	 In the Tools Palette, select the Selection Tool 

2.	 Click on the Annotation icon you wish to append. A window will 
appear displaying the annotations for this particular icon.
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3.	 Ctrl-click (Mac) or right-click (PC) on the expanded Annotation 
and select Append.

4.	 The Append Annotation dialogue appears. Enter the new 
Annotation then click OK.

5.	 The Annotation window will update placing the latest Append at 
the bottom.

To append an Annotation using the Annotation Window: 

1. 	 Click the Window menu, then select “Show Annotation 
Window.”  A dialogue similar to the one below will open.  

2.	 The window shows a list of all the annotations on the page, when 
the annotation was made and by what User. Click the Annotation 
that you want to append, ctrl-click (Mac) or right-click (PC), then 
select Append.
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3.	 The Append Annotation dialogue appears. Enter the new 
Annotation then click OK.

4.	 The Annotations Window will now show the appended 
Annotation. Click the triangle down to show all appended 
Annotations.

	 Note: �Annotations can only be Removed or Locked by the original creator.

Rotating Proof Views
1.	 Open the proof you want to view. By default, the Proof should be 

in the heads-up orientation.

2.	 From the View menu, select the degrees you wish to rotate the 
proof. The choices:

	 Rotate 90 CW (90 degrees clockwise)
	 Rotate 90 CCW (90 degrees counter-clockwise)
	 Rotate 180 (180 degrees)

	 OR

3.	 From the bottom of the Proof window select the degree rotation 
for the Proof to be set.

	 Note: �The View menu changes the current view of a Proof by the degree 
chosen. The bottom of the Proof Window sets the Proof view to the 
chosen degree.
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4. 	 The proof will rotate according to your selection. The image will 
stay rotated until you select a different rotation or close the proof.

Approving / Rejecting Proofs

Approval is the final process for a page viewed over Rampage Remote. It tells 
the printer that a page is ready to continue to the press stage. The following 
instructions explain how to Approve/Reject a proof. There are a two ways to 
Approve/Reject a Proof.

1.	 Click the area flashing “UNDECIDED” at the bottom of the 
Proof Window.

2.	 In the Approve/Reject window, type any comments, then click 
Approve/Reject.

OR

1.	 With the Proof open, click the Approve/Reject icon from the 
Tools Palette.

2.	 The appropriate window will appear for the Approval or 
Rejection of the Proof. Type any comments then click Approve/
Reject.

3.	 The Global Status in the Page Browser for the page will now be 
updated to show the appropriate icon or frame color for Approve 
or Reject. For more information on the Page Browser, refer to 
that section earlier in this document.
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Batch Approve/Reject
When viewing pages in the Page Browser, you can select more than one page to 
Approve or Reject. 

  1.	 Select the Pages in the Page Browser, this can be done in any of 
the views. To select all of the pages, use Select All under the Edit 
menu.

  2.	 Access the contextual menu (ctrl-click Mac, right click PC).

  3.	 Select either Approve or Reject. One of the following windows 
will appear depending upon the selection.

   

  4.	 Prior to clicking Approve or Reject, you can also add comments. 
The decision will be sent to the Rampage Remote server and the 
pages will be updated.
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Approval Lists

There are two different views for the Approval List. These views are only seen 
in the Page Browser when using the List view. The first one below, shows the 
different global status of Pages as well as individual decisions by Users allowed 
to Approve/Reject Pages.

The second view shows an Approval List with Stages. These Stages are set up by 
the Rampage Remote Administrator. The List shows the same status of Pages as 
well as the different Stages. See the rules below on Stages.

The Rampage Remote Administrator can create as many stages as needed. All 
users in all stages will be able to view the pages and make decisions on the page 
up until the global status of the page has changed to Approved or Rejected. 

Rule #1: � The global status can only change to Approved after each 
and every user of each stage has approved the page.

Rule #2: � The global status can only change to Rejected if one of the 
following criteria is met: 

	         �All decisions required for Stage 1 are made and one or 
more of the decisions was to reject the page.
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		  OR

	         �All decisions required for a given stage are made and one or 
more of the decisions was to reject and all previous stages 
are approved.

Take the following example :

	 I have 3 stages for a Job called Remote_1.3. I’ll call stage one 
Legal, stage two Creative and stage three Final. Each stage 
contains 3 users.

	 Legal  (Requires at least 2 decisions)

		  Legal1, Legal2, Legal3

	 Creative  (All decisions are mandatory)

		  Creative1, Creative2, Creative3

	 Final  (All decisions are mandatory)

		  Final1, Final2, Final3

The following is how a page rejection can happen. 

    •	 If 2 of 3 users in the Legal stage make their decision and 1 of 
their decisions is reject, then the global status of the page will trip 
immediately to Rejected, regardless of any decisions made or 
not made in the Creative and Final stages. 

    •	 If 2 of 3 users in the Legal stage approve the page and if all 
users in the Creative stage make their decision and at least 1 of 
the decisions is reject, then the global status of the page will trip 
immediately to Rejected, regardless of any decisions made or 
not made in the Final stage. 

    •	 If 2 of 3 users in the Legal stage approve the page and if all users 
in the Creative stage approve the page and if all users in the 
Final stage make their decision and at least 1 of the decisions is 
reject, then the global status of the page will trip to Rejected.

The following is how page approval can happen.

    •	 If 2 of 3 users in the Legal stage make their decision and their 
decision is approved then the page passes stage 1. If all 3 users 
in the Creative stage make their decision and their decision is 
approved then the page passes stage 2. If all 3 users in the Final 
stage make their decision and their decision is approved then 
it passes stage 3. Stage 3 being the final stage and everyone 
approving, will trip the global page status to Approved. 

	 Note: � All users in all stages can make their decision at any time. In other 
words stage 3 users can make their decisions before anyone in stage 1 
or 2.)
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Job Browser
�A Job Browser window has been added for all jobs. This window will display 
Job Stats like total pages, total pages ripped, etc.

  1.	 From the Window menu in Rampage Remote select Show Job 
Browser.

   2.	The Job Browser window will open to show the list of Jobs.

  3.	 Select a Job from the list on the left and the status of the Job will 
be displayed in the window.

The Job Completion area is based on the criteria of the flats plotted. The Pages 
and Flats areas display the status of each criteria shown.
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Download / Color Managing Proofs

Rampage Remote has a feature that allows you to download proofs. You can 
download a PDF or JPEG file in either RGB or CMYK. One feature available 
during download is the ability to apply an ICC Profile to an RGB proof as it 
is downloaded. You can then output the RGB JPEG or PDF to an ICC-capable 
device to get a fairly accurate representation of final color.

	 Note: � You must use a separate application to print the downloaded file.

Downloading and Color Managing Proofs

To download a proof: 	

1.	 Select Download Proof from the File menu.

2.	 Select the Format, either PDF or JPEG.

 

    •	 In the Pages & Layout window, there is a Stitching option 
for the PDF File Format. If you have selected more than one 
page to download you can Stitch the pages into one file or 
Keep the pages separate. See Multiple Downloads for more 
information.

3. 	 Select the Quality Options pop-up menu. The options correspond 
to what you plan to do with the saved PDF or JPEG file. 

 

    •	 DPI – Low (150dpi) should be used for screen-proofing. 
Medium (180dpi) should be used when you want to save disk 
space, but plan to output to a high-resolution proofer. High 
(300dpi) should be used for high-resolution proofers. 

    •	 Image Quality – Use the slider to increase or decrease the 
size of the file. The smaller the file, the lower the quality.
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4. 	 Select the Color Options pop-up menu. Both the PDF and JPEG 
files have the same selections for RGB and CMYK Color space.

    

    •	 Select RGB or CMYK Color space. If RGB is selected you 
can then select the ICC Profile you wish to run the proof 
through and the Rendering Intent. If you do not want to ICC 
color correct the proof, select None.

		  Note: �The ICC Profiles that are listed here are assigned by the Rampage 
Remote Administrator.

		  Note: �Color Correction is not available if CMYK Color space is chosen.

5. 	 Select the Annotation Options pop-up menu. Only the PDF File 
Format has the options available.

 

    •	 Burn Icons onto Proof – If this is set to Yes, you will see 
the various Annotation icons on each proof. If set to No, the 
icons will not be visible on the proof.

    •	 List Annotation – If this is set to Yes, a separate page with 
the Text Annotations will be included in the PDF. If set to 
No, the Annotations will not be listed.

    

6. 	 Select the Header/Footer Options pop-up menu. Only the PDF 
File Format has the options available. Any information set in the 
Header and Footer menu is saved in preferences, so they do not 
have to be set for every download.
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    •	 Header/Footer – Select the location of the additional 
information. The Header is placed at the top of the page. The 
Footer is placed at the bottom of the page.

    •	 Font/Size/Color – Select the text variables of the Header/
Footer.

    •	 Align – Select the alignment of the additional information, 
left, center, or right.

    •	 Auto Text – The pop-up menu lists some common variables 
for Header/Footer information. When you select a variable, 
it is listed in the window below. You can type in custom 
information in the window provided. See example below.

The resulting PDF will contain the header or footer information. The picture 
below contains the common variables from the pop-up menu.

 

7. 	 Click Download. In the Download dialogue, type the name of 
your downloaded file, then choose the location you wish to save 
your downloaded proof. Click the Download button.

Depending upon the number of pages and the options you choose, it may take 
several minutes to download the file. The Download Manager window will 
appear, if it was not already open, showing the file name, the size, and the status 
of the download. If you downloaded a JPEG file and there were any annotations 
on the file, they will not be shown. If you downloaded a PDF file, the annotations 
will be included in one file if the option to have annotations was selected when 
downloading the PDF.
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Open Downloaded Proof

From the Download Manager window, you can select a PDF, double-click to 
open it, and view or print the file.

            

Downloading Multiple Proofs

In any view of the Page Browser, you have the ability to download more than 
one Proof at a time.

 1.	 Select the Pages to download.

 2.	 Ctrl-click (Mac) or right-click (PC), then select Download.

 3.	 Follow the steps explained in the previous section to continue 
with the Download process.

Downloading Books

When viewing a Job in the Page Browser using Book view, you have an option 
in the contextual menu, Download Book. This option will download all pages 
shown in Book View.

	 Note: �The Download Book selection is only available if a Job has been set 
up by the Rampage Remote site.

  1.	 Open the Page Browser and select a Job from the left column. 

  2.	 Make sure Book view is selected.	

  3.	 In the Page Browser window, ctrl-click (Mac) or right-click (PC) 
to bring up the contextual menu.
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  4.	 Select Download Book. The Download window appears. Select 
all of the settings necessary to continue with the download. If the 
Job contains Blank or Unassigned pages, the resulting PDF will 
have a Blank page or one that says Not Available (Unassigned).

		    Note: You do not have to have any pages selected to Download Book. 

Print Current Proof

A Printer icon has been added to the top of the proof window and Print has been 
added to the File menu. This will print the proof that is currently open. If the file 
is enlarged, has guides, annotations open, etc., that is what will print, basically a 
screen shot of the proof window.

            

Logout

Within the Proofing section of Rampage Remote, a Logout button has been 
added to the toolbar. You no longer have to hit the browser back button to Logout 
of Rampage Remote.
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